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| Read This First

B Disclaimer

» While every effort has been made to ensure that the information contained in this
guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

» Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software, memory
cards (miniSD Cards), personal computers, or peripheral devices, or due to use
of a memory card not initialized by a Canon camcorder.

B Trademark Acknowledgments

* QuickTime is a trademark of Apple Computer, Inc.

« Microsoft® and Windows® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

- S, Mii and 22 are trademarks of SD Card Association.

» Other names and products not mentioned above may be registered trademarks
or trademarks of their respective companies.

© Canon Inc. 2007 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support data
CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could

damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.

Checking Supplied Accessories

Use the following accessories to download recorded still images from a memory card
to your computer.

* IFC-300PCU USB Cable * DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The steps
and windows may vary depending on your computer and the version of software.
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| System Requirements

Please install the software on a computer meeting the following minimum
requirements.

0OsS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.

CPU: Pentium 500 MHz or better

RAM: Windows 98/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/Windows

2000/Windows XP systems with built-in USB ports

Free Hard Disk Space: <+ Canon Utilities
- ZoomBrowser EX: 200 MB or more
» Canon DV TWAIN Driver: 25 MB or more
» Canon DV WIA Driver: 25 MB or more

Display: 1024 x 768 pixels or better/High Color (16 bit) or better

@ O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
\&¥ o Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
O A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft® Windows® 98 Second Edition: Windows 98
Microsoft® Windows® Millennium Edition: Windows Me
Microsoft® Windows® 2000 (Service Pack 4): Windows 2000
Microsoft® Windows® XP Home Edition or Professional

(Service Pack 1 or 2): Windows XP

System Requirements I 5



| What is Digital Video Software?

The following software will be installed by installing the Digital Video Software.

B ZoomBrowser EX

* Viewing downloaded still images

 Categorizing, organizing, and searching large volumes of still images
« Editing still images

» Changing the data for still images and save them as new files

* Viewing still images in a slide show

» Adding sound to a still image

B CameraWindow

* Downloading still images from a disc or a memory card to your computer

* Viewing still images recorded on a disc or a memory card

* Printing still images recorded on the disc or memory card without downloading
the still images to the computer

B USB Driver

* Driver software that enables you to download still images from a disc or a
memory card to a computer. Users of Windows XP do not need to install this
driver software. An OS standard driver will be installed automatically.

» Windows 98/Windows 2000: Canon DV TWAIN Driver

* Windows Me: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do with the

main features and how to operate them. For more detailed operational instructions,
refer to the Help menu of each software program.

I What is Digital Video Software?



| Windows

CameraWindow

CameraWindow is a program created to download still images from the disc or
memory card to the computer. Furthermore, you can print still images recorded on the
disc or memory card without having the images downloaded to the computer ([ ] 39),
and you can confirm and change the owner name of the camcorder you specify

([11 83). Refer to Starting CameraWindow ([_]] 28) for launching the software. The
Remote capture function is not supported by the camcorder.

B [Acquire Images] Tab
This tab is used for downloading still images recorded on the disc or memory card by
connecting a camcorder or a card reader/writer to the computer.

Camera Control window

& CameraWindow - Canon, F:E ok ok

Selects a function in the Camera _{-"-"-C':IU"EWEQES Print | Setto Camera | Remate shooting)
Control window.

Downloads uzing camera

» @&N Press the camera's button

Images will be downloaded to 1
the computer, and ZoomBrowser EX e
starts. |

‘ é@ Starts to download images

Images in the camcorder are =——— [
displayed aIIowing you to select Lets you select and download images
images.
>
PIaCing a check mark here makes /| Diigplays this screen when the camera is connected

the Camera Control window to open
automatically the next time you Preferences...

connect the camcorder.

Specify the image type to be downloaded and
the destination folder.
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MW [Print] Tab

This tab is used for printing still images on the disc or memory card without having the
images downloaded to the computer. The window varies depending on the selected
printing type. Refer to Printing Still Images Recorded on the Disc or Memory Card
([1139).

Camera Control window

& CameraWindow - Canon, 4 4k

Prints all Stl” Images In the disc or = 'Acquirelmages| Print |Set ta Camera | Femote shooting |
card one image per page. I

~iF| Print All Photos
Prints all still images in the disc or — E
card as an index page (rows of _
images with file names and image =

. X £50° | Print Contact Sheet with All Photos
information). =

Prints according to the DPOF print ——| | Print according to DPOF settings
settings set by the camcorder to the
still images recorded on the card. |

= Select an image and print

Displays a list of the still images —— il B N
in the disc or card, allowing you
to select which ones to print.

Dizplays thiz screen when the camera iz connected

Prefaiences. . Fimizh

Unable to set the DPOF print settings to the still images recorded on the disc.

=)
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B [Set to Camera] Tab

This tab is used for confirming and changing the owner name of the camcorder you
can specify ([1] 83) and uploading the still images to the card. My Camera function is
not supported by the camcorder.

& CameraWindow - Canon, ¥ 44 3k

:-.f.-\c:quirelmages-' Prirt | Set to Camera |.F!em0te shooting-é

Camera Control window

Set My Camera

Confirmsfchanges camera settings

Enter or change the name of
the camcorder’s owner.

&

Uploading the images from the —lﬁ Uploads images to the camera
computer
Dizplays thiz screen when the camera i connected
2Py Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera]

<4 window. If you click [Creating My Camera data] in the [My Camera] window,
[My Camera Maker] will be launched. [My Camera Maker] is a program that
enables you to create and import My Camera contents (Start-up images, Start-
up sound, Shutter sound, Operation sound and Self timer sound) to
camcorders that support this function. Your camcorder does not support the My
Camera function.
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B Camera Browser Window

Prints the selected still images.
Starts ZoomBrowser EX.

Selects the still image selection method.

Changes the size of the thumbnail.

File(F) EdtE) Wiew(v) H

& CameraWindow - Ca I-
D(H)

; — ﬂ File Infarmation:
Image Download [__ E! Print = @Start ZoomBrowser EX FileMame:  IMG_D101JFG

= Modfied:  200/01/1514:43:2,
B Select v = =3
e ) FileSizs:  BOKB

Image Size:  E40:450

ﬂ Hiztograrm:

;-‘

IMG_0101.PG IMG_0102.PG IMG_0103.PG IMG_0104.PG

ﬂ Dretailz:
Tkem Mame Yalue I
File Marme IMG_010

Camera Model M., Canon
Shoating DatefTi... 1/15/200
Shooting Mode Portrait
Fhoko Effect Off

T (Shutter Speed) 1740

Ao (Aperkure Yal... 2.0

Light Metering Ervaluativ

Exposure Cormp.., 0O

150 Speed Auto

Lens 2.6 -85

Focal Length 7.9 mm

Digital Zoorm Mone

Image Size 640480
\ Image Quality Fine v

L™ M

Selects imag| 1 of 4

Selects whether to show or hide the image
frame and file name.

Still image information and a histogram
(This will not be displayed when using a card reader/writer.)

@ If your camcorder supports wide size still image (16:9 such as 1920 x 1080

\&¥] pixels) recording, the thumbnails that appear in this window will be also 16:9
images. The sample images used on this instruction manual are normal size
still images (4:3).

File{F) EditiE) Wiew(y) Help{H)

=t = T
A >
), Image Download ™ :! Print - ﬁstart ZoomBrowser EX
-
By Select ~ ! ,j =@

IMG_0101.JFG IMG_0102.JPG IMG_0103.JPG
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Main Window

ZoomBrowser EX is a software program used for organizing, printing and editing the
downloaded still images. If you wish to start ZoomBrowser EX without connecting the
camcorder or card reader/writer, double-click the Z@;ﬁ on the desktop, or click the
Windows [start] menu and select [All Programs] » [E}‘ianon Utilities] » [ZoomBrowser
EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click E§ or select [Exit] from

the [File] menu.

#7 ZoomBrowser EX - C:\Documents and Settings\Canoniy DocumentsiMy Pictures | E]E|

File Edit Wiew Tools Internet Help

rTasks 3 r @7 Slide Show Q Search ]
| \

I@ fioquite & Camers Setiings me Mod | SerallMade | Preview Made

| o Frctres t [®H-0- (k& e [ Pt Twol )

9} 200%_01_15

=
1 — [;"“ Yigw & Classify

( Favorite Folders | ) Falders )

Last Acquired Images

2 e | | ) [Z]) Al Images

= #H shooting Date
[E) zo0x_01_15

B ]

Farvorite: Folders

= (9 My Pictres
4] 200%_01_15
) 200%_01_20

3 search Results

| Selected Ttems: 0

1 Task Area

[Acquire & Camera Settings]: Use this to display the Camera Control window to
download still images, to print stillimages without
having them downloaded to the computer and to
configure the camcorder settings.

[View & Classify]: Use this to view and organize still images.
[Edit]: Use this to edit still images.
[Export]: Use this to change the data for still images and

save them as new files, extract still images from
movies, back up to CD-R/RW (Windows XP only),
or export shooting properties to a text file.

[Print]: Use this to print downloaded still images.
[Internet]: Use this to attach selected still images to E-mail
messages.

Windows I 11



Folders Area

You can select a folder to be displayed in the Browser Area. In the [Last Acquired
Images] panel, the newly downloaded still images are placed into virtual folders
classified by recording dates. In the panel below, the folders where the downloaded
still images are actually saved in are displayed. Selecting the [Favorite Folders] tab
shows only the folders that are registered as favorites. The [All Folders] tab shows
all available folders. E indicates that newly downloaded still images are in the
folder.

To register folders as Favorites, follow the instructions below.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

To remove the registered folder, select the folder, and click [Remove].

Browser Area

This area displays the images contained in the selected folder. If you place the
cursor over a thumbnail in the browser area, will be displayed at the upper right
corner. Clicking skips over folders to zoom in directly on the intended folder.

o Clicking on 2 images while holding down the [Shift] key selects also all

& images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple
images.
4 Browser Area Tool Bar
The menu items vary depending on the View Mode.
1 2 3 4 5 6 7 8
I I : R — |
- O - |_h; L Q 4y S _|_-——-‘ [ 4,% Filker T ool ]

1 | Previous/Next | Displays the previous/next image in the current folder.

2 (Up Displays the folder in the upper tiers of the hierarchy.

3 | Select Allows you to select all images and deselects images.

4 | Information Allows you to select the information to be shown. You can also
hide the pop-up window by clearing the checkmark. The pop-up
window appears when you move the mouse over a thumbnail.

5 |Pan Changes the area displayed when you zoom in on a folder or
image in the Browser Area and drags the thumbnail list.

6 | Restore Changes the size of the thumbnail list to fit the window.

Display Size

Zoom Slider | Enlarges/Reduces the thumbnails in the Browser Area.

Filter Tool Allows you to select which still images to display according to
the star rating. When you download the images, the star rating
is set to two stars as a default. To change the star rating, refer
to Applying Star Ratings and Keywords ([ ] 48).

Windows




5 View Mode
You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

Zoom Mode | GerallMode | Preview Mode |
My Pictures € > 2 [H-0-[A&Q e ([ B Pt Todl

3] 200%_01_15

IMG_0101.0PG  IMG_0102. PG

IMG_0103.0PG  [MG_0104.0PG

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name.
Clicking a folder displays enlarged images. Selecting [Preferences] from the
[Tools] menu opens the [Preferences] window, on which you can select the
hierarchy of folders. In the screenshot below, [Maximum scroll mode folder
depth] (hierarchy of folders) is set to two.

Zoom Mode | Scroll Mode | Preview Mode

My Picures €32 (B0 [
175 o 5 S BRCREE
(¥) _J 2oo%_01 20 Hb &=, 00,00

[Preview Mode]: Double clicking the folders at the bottom of the window, opens
the folder and shows a large still image in the folder along with detailed information.
You can change file name and comments. To display another image, click
[Previous]/[Next] or select an image shown at the bottom of the window.

Zoom Madz | Geroll Mods | PreviewMode |

200%_M_15 € t -0 - | 7l

[Z] File Infomation: ia®

File Nare: [ IME_0101
Modfied 1152008 [ Protest
Fil Size 28KE

Image Size: 640 x 480

DataTyps: I

Sound:

[ 2] Star Rating
TR AN
2] Comment 3

i Keywords:
Brightriess Histoararn:

[ —
[ 2] Shoating Information:

Item Name Value

File Name IMG_0101.JPG

Camera Model Name  Canon sokskok

Shooting Date/Time  1/15/200% 3:25:50 Ak b
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6 Application Tool Bar

1 2 3 4 5 6

§| Yiew Image Properties b? Slide Show {@ Seatch % Delete ng Ratate

1 | View Image Displays a selected image in the [Image Viewer] window.

2 | Properties Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in
[Preview Mode].

o Properties
Modified: 1415/200%
File Size: 828KB
Image Size: B40 % 480

“ Data Type: PG
Sound

Path:  CitDacuments and Setings\Cananihly Dacu

(] Fie Name:
ME_o101

[A] Star Rating:
[ Protect
[%] Comment

[ Kepwords
Wiew/Madily Kepnards ...

[ Brightress Histogram:

File: Mame IMG_0101.JPG

Caron s ook
Shooting Date/Time  1/15/20052 4328 PM
Shonting Mods Pattiat
Phaoto Effect Off
Ty (Shutter Speed] 1440
G MBnerhiie vahie] n

f‘L

Slide Show Displays still images in a slide show.

Search Allows you to search for images ([ 1] 53).

Delete Deletes selected images.

oloa| Al W

Rotate Rotates selected still images. A movie cannot be rotated.

14 I Windows



[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View Image]
or double-click an image.

1 2 3 4 5 67 8 9

Zoom Ratio: 100%

Previous/Next Displays the previous/next image in the current folder.
2 | Zoom In/Zoom Out | Enlarges/decreases a still image.
Pan When the image is larger than the window, you can move
the image in the desired direction.
4 | Print Prints the selected still image. Refer to [One Photo per
Page Print] ([ 1] 44).
5 | Edit Allows you to perform the following operations: red-eye

correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting texts or
registering external image editing applications.

6 | Auto Focus Frame | This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.
Information
Show Allows you to display multiple images at the same time.
Synchronize Synchronizes the View functions across all displayed
images.
10 | Fit to Window Matches the image size to the size of the Image Viewer
Window.
11 | Restore Restores the standard display size.
12 | Zoom Slider Allows you to enlarge/decrease the displayed image.

Windows I 15



13 | Show Image Full Displays an image in full screen size.
Screen

14 | Change the Star Allows you to change the star rating.
Rating

15 | Capturing Frames | Extracts still images from movies. (Windows XP only)

B [Red Eye Correction] Window
Selecting [Red Eye Correction] from the [Edit] menu or the [Eei - icon allows you
to correct the red eye effect on a still image in the [Red Eye Correction] window.

ion - C:\Documents and SettingsiCanoniMy Documentsh200% 01 _15\MG ... |;‘@E

1
2
[[15how Original Image
=] | Q 0 [0
- Cow )
Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 | Manual Mode Point the cursor on a red eye so that the area is
highlighted green, and left-click the mouse.

16 I Windows



B [Auto Adjustment] Window
Selecting [Auto Adjustment] from the [Edit] menu, or clicking the Eied - icon and
selecting [Auto Adjustment] allows you to automatically correct the color balance of

the still image.

Auto Adjustment - C:\Documents and SettingsiCanoniy Documentsi200X_01_155MG_01... ] y |EHX|

Auto Adjust Image

Show Original Image

QAN ot

B [Color/Brightness Adjustment] Window

Selecting [Color/Brightness Adjustment] from the [Edit] menu, or clicking the
&e - jcon and selecting [Color/Brightness Adjustment] allows you to adjust the
brightness, saturation, contrast, intensity levels, tone curve and RGB of the still

image.

B Color/Brightness A djustment - C:\Documents and SettingsiCanoniMy Documentsi200X_01... _,|E‘b_<|

Please select adjustment option:
| Color djastment ~]

Bighiness —— |
€ Saturation: ‘_J_
0—

Contrast: —

Q Q M |E [ Unda Al Unda Fied
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B [Sharpness] Window
Selecting [Sharpness] from the [Edit] menu, or clicking the &=« - icon and
selecting [Sharpness] allows you to emphasize and clarify the outlines of people
and objects.

Sharpness - C:\Documents and SettinpsiCanoniiy Documentsi200%_01_155MG_0104. PG ‘:JE‘E'

Sharpen | Unsharp Mask |

Amount. Ji

B [Trim Image] Window
Selecting [Trim] from the [Edit] menu or the =t - jcon allows you to crop a still
image. Either drag the mouse on the image or specify the cropping area, and click
[Trim Image].

B Tirim Image - C:3ocuments and SettingsiCanonWy Documentsi200%_01_154MG, 0103, JPG ‘Zl@gl

Trim saitings.

Location [top-eft comer]:

¥ |0
¥ |0
Size of timming arsa
=
Wi
=
H D

Cancel
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M [Insert Text] Window
Selecting [Insert Text] from the [Edit] menu, or clicking the &=t - jcon, and select
[Insert Text] allows you to write text on still images.

B Insert Text - C:\Documents and SettingsiCanoniiy Documentsi200%_01_154MG_0104.JPG ‘:,lﬁ‘gl
Insert Text
Fart Nare:
Font Size:

Text Color:

Test Attribute: B 7 0
[#] Antislizs

Teut

<Select the location on the image first, then
type your text in heres

TI& & O |

o8 _These image correctio_n too_ls can be selected by clicking [Edit] » [Edit Image]
s in Task Area of the Main Window.
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| Installing the Digital Video Software

(D

O Be sure to install the Digital Video Software before connecting the
camcorder to the computer.

0o Users of Windows 2000 or Windows XP must first log in as an Administrator
to install programs.

Windows XP Users:

Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (the software such

as the [Scanner and Camera Wizard] starts automatically).

However, please note that there are several limitations to downloading still

images with this method. To avoid these problems, install ZoomBrowser EX to

download still images.

o It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

Set the DIGITAL VIDEO SOLUTION DISK in the computer’s
CD-ROM drive.
If the installer panel does not open automatically, use the following procedures
to display it.
- Windows 98/Windows Me/Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
Depending on the setting of your computer, the file extension “.EXE” may not
appear.

Select your country or region.

Select your language.

Installing the Digital Video Software



5 ciick Digital Video Software [Easy Installation].

To select the installing software, click [Custom Installation].

Canon
Installer Panel — DIG"ALVIDEO
Solution Disk
Digital Wideo Software

Easy Installation
i

Autornatically inskals al softwars.

Custom Installation /I
—

Select the software that you want ta install.

QuickTime &.5

( Install \
. 4

( Exit

6 If other software is running, close all programs and click
[OK].

Start installing Digital Yideo Solution Disk,
Close any other open applications and click [Ok].

Installing the Digital Video Software I 21



T Review the installation settings and click [Install].
When you have selected [Custom Installation], depending on the Windows OS,
you need to have one of the following USB drivers installed on your computer.
Please select and install the appropriate driver.
* Windows 98/Windows 2000: Canon DV TWAIN Driver
* Windows Me: Canon DV WIA Driver
* Windows XP: No driver is necessary to be installed.

Confirmation

@ ZoomBrowser EX 155 MB
License o ||
ai, EOS Utility 20ME

step 3 Installation

N

step 4 Finish

View a description of the software by passing your mouse over the name of the
software,

C:\Program Files\Canor,

Click [Install] to start installing.

‘ Back |

o When installing the software on Windows 2000 or XP by selecting [Easy

4 Installation], EOS Utility (a software for downloading still images from the
Canon EOS Digital SLR Cameras) will be installed. This software is used only
for compatible Canon EOS Digital SLR Cameras, and the camcorder does not
support this software.

8 Read the license agreement and click [Yes] to accept the
terms and to start installation.

License Agreement

Flease read the following License Agreement carefully before instaling the
software.

Ligehae IMPORTANT NOTICE
This software contains the Adobe color profiles (Adobe RGE{1998), Apple RGE,
ColarMatch RGB, Wids Gamut RGE), and which are licensed under the Following
stepd  Installation Adobe SYSTEMS INCORPORATED COLOR FROFILE LICENSE AGREEMENT, This
software other than such Adobe color profiles is licensed under the Following
Canon Scftware License Agresment,
stepd  Finish

CAMON SOFTWARE LICEMSE AGREEMEMT

IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE! This
document is a lsgal agresment ("Agreement”) betwesn vou and Canon Inc.
{*Canan") and gaverning yeur use of this software, and orline manual or ather
electranic documentation, and sound daka and image data, I any (the "Software").
BY INSTALLING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT. IF YOI DO MOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY STOP THE INSTALLATION PROCESS,

1. GRANT OF LICENSE

(1) Canen grants you a nan-exchusive license ta use ('use’ shall mean staring,
loading, instaling, executing, or displaying) the Software on your camputers solely

For use with Canen product. Vou may allow other users of Canon's product touse v

Click [*fes] to accept the License Agreement. If you click [Mo], the installation
of Digital Wideo Solution Disk will be canceled.

No
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9 click [OK].

m ZoomBrowser EX.
Tnstalled
m ol ECS Utiity
Installed
Installation

 ZoomBrowser EX
' EOS Utility

stepd  Finish

\U

10 When the installation is complete, select [Restart computer
immediately (Recommended)] and click [Restart].

|| Installation of the software has been completed.

JJ ( Restart computer immediately (RetnmmendedD
o Finish
— (

:

2¥q When you do not need to restart the computer, the [Finish] screen will be
& displayed. Click [Finish]; remove the DIGITAL VIDEO SOLUTION DISK from
the CD-ROM drive, and proceed to Before Downloading Still Images ([ ] 25).
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11 When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK
before you connect the camcorder to the computer.

2Py Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN
Z Driver or WIA Driver have only been copied to your computer. To download
images via USB connection, finish installing the TWAIN Driver or the WIA

Driver. For details, see step 6 ([.T]25) in Connecting the Camcorder to a
Computer.

24 I Installing the Digital Video Software



| Before Downloading Still Images

Connecting the Camcorder to a Computer

@ O Be sure to install the Digital Video Software before you connect the
\ o /| camcorder to the computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

o The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

o Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

7Py © Refer to your computer manual for the location of the computer’s USB ports.

4 0o See your camcorder instruction manual for how to connect the camcorder to
the computer and how to change the media setting (MEDIA SEL.) in the
SYSTEM SETUP menu.

Insert a disc or memory card containing images into the
camcorder.

Connect the power adapter to the camcorder.

Turn the power switch to ON and change the camcorder
mode to PLAY by sliding down the power switch.

Move the 'S /|y to ).

AAbDh WON -

To download still images on the disc select DISC in the
MEDIA SEL.&3 from the SYSTEM SETUP menu.

To download still images on the card select CARD in the
MEDIA SEL.©3 from the SYSTEM SETUP menu.

Wait until the camcorder’s access indicator stops flashing.

6 Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
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* The first time you connect the camcorder to the computer:

- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV
WIA Driver (Windows Me) starts.

- If the “Digital signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.

* Windows 98/Windows 2000/Windows XP: A window appears allowing you to
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to
close the Wizard.

* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images (ZoomBrowser EX) ([1] 27).

USB Terminal USB Cable

~¢— Camcorder End Computer End —»

USB Port on
the Computer
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| Downloading Still Images (ZoomBrowser EX)

@ O Proper operation when connecting to a computer or printer cannot be
¥ guaranteed if the disc inserted into the camcorder was recorded or used in a
non-Canon digital device.

o Observe the following precautions when the camcorder’s access indicator is
flashing. Failure to do so may cause disc or memory card data to become
corrupted.

- Do not open the disc or memory card cover, remove the disc or memory
card or detach the USB cable.

- Do not turn off the camcorder or the computer.

- Do not change the position of the power switch or the "™ /€3 switch.

O Images recorded onto the disc, memory card or downloaded to the hard disk
are important original data files. Create a copy of the file first before working
on it on your computer.

0O Do not rotate the image in the [Windows Picture and Fax Viewer] or in the
explorer view. The data for the original image will be changed and the image
can no longer be displayed in ZoomBrowser EX or on the camcorder.

o If the Server Busy window appears when you connect the camcorder to the

computer, click [Retry].

Thiz action cannot be completed becauze the ather
? program is bugy. Chooze "Switch To' to activate the
- buzy program and correct the problem.

0O You cannot connect the camcorder to a computer if the disc or memory card
contains more than 1800 images. When using a memory card, please use a
card reader/writer to download the still images; for the disc, please use your
computer’s DVD drive. When using the DVD drive to download the images
recorded on the disc, it is necessary to insert a finalized disc.

- You cannot record any new images on the finalized DVD-R disc or
unfinalize it.

- For instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer ([ ] 36).
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Starting CameraWindow

1 Connect the camcorder to the computer ([1] 25).

2 Select [Canon CameraWindow] and click [OK].

« If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon ¥ & ¥ %

Camera connected

Select the program to launch for this action:

st Canon E0S Likility

P 5]

gz Downloads images from EQS camera

Shir ) Microsoft Scanner and Camera Wizard
Diownload pictures from a camera or scanner

[ &lways use this program for this action

» The Camera Control window opens.

&L CameraWindow - Canon F3 F 4 4

{r— — —
Acquire Images | Print SettoCﬂera Fiemote shooting

Downloads uzing camera

‘1' & Q&N Press the camera's button

co==tal

Downloads using computer

@l Starts to download images

| =

%@ Lets you select and download images

[+] Displays this screen when the camera is connected

2% © If the camcorder is already connected to the computer, you can start the
& CameraWindow and display the Camera Control window by clicking [Acquire
& Camera Settings] followed by [Connect to Camera] in the ZoomBrowser
EX Main Window.
o The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images
You can select a downloading method in the Camera Control window.

B Auto-Downloading

1 Click [Starts to download images] in the Camera Control
window.

* For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ([ ] 30).

* Click [Finish] to close the Camera Control window after downloading images.

ﬂ CameraWindow - Canon & & &3 &

Acquire Images | Print | Set to Camera | Femote shooting

Downloads uzing camera

e ‘:J&N Press the camera's button

Diizplays thiz screen when the camera is connected

Freferences...
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B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon

' | Acquire Images |!3nnt Set to Camera | Remate shaoting

‘ Downloads uzing camera

s Q&N Press the camera's button

= i
j;?l Lets you select and download images

[/] Displays thiz soreen when the camera is connected

| Preferences... |

2 Select [Change auto download settings] and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

() Change direct transfer download destination folder

(@ Change auto download settings )

Cancel
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3 Select the image type to be downloaded and click [Next].

CameraWindow - Auto Download Settingsi1)

Select the image type to be downloaded.

(%) Mew images

() Allimages

(") Images whosze print order settings were specified with the camera

() Images whose transfer gettings were specified with the camera

Download Options

s |'when the download i complete, the ariginal image iz deleted from the camera.

Place a check mark here ——
if you wish the original image
in the camcorder to be

deleted after downloading. oot @ o> D[ Come

@ o The still images recorded on the disc will not be marked as “already
\ o/ transferred” after downloading.
o When downloading from the disc, the still images on the disc will not be
deleted even if the [Download Options] is selected (a check mark is placed).

4 Specify the destination folder settings and click [Next].

Cameralindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder
A new folder will be created for each of the images' shoating dates in the following folder,

and the images will be zaved there.

I s =

s D ozuments and Settings Canoniiy Documentsibdy Pictures

=

Click this button Bronse..

to specify the Create Subfolder

destination folder. * Shaoting YearhonthDate v
E xample:

Select to specify —= (] C:\Documents and Settings\CanontMy DocumentsiMy Fictures

the name cﬁ‘ they A

subfolder.

< Back Cancel
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5 Specify a process to perform after the image is downloaded.

CameraWindow - Auto Download Settings(3) [5_<|

Specify process to perform after image is downloaded.

(%) Display the folder at the save destination

() Perform selected processes conzecutively

< Back Cancel

Below window will be displayed when you select [Perform selected processes
consecutively] (You can redisplay the window by clicking [Select]). Select a
process to perform after the image is downloaded, and click [OK].

Select Process

Pleaze zelect a tazk to run after pour images
have been downloaded:

%) View as a Slide Show
) One Photo per Page Frint
() Index Frirt
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6 Click [Finish].

x)

CameraWindow - Auto Download Settingsi4)

Enable or disable the image auto-download function.

PIaCing a CheCk mark | Images are automatically downloaded to computer while camera is connected
here makes images in

the camcorder to be
automatically downloaded
when the camcorder is
connected.

< Back Cancel

B Downloading the Selected Still Images from the CameraWindow

1 Click [Lets you select and download images] in the Camera

Control window.
The CameraWindow opens.

& CameraWindow - Canon ok ks
Acquire Images | Print | Set to Camer;"Emote shiooting

Downloads uzing camera

PV ] \-'-’JQN Press the camera's button
——

LT

L

[ L Lets you select and download images

Diizplayz thiz screen when the camera is connected
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2 In the CameraWindow, select the image you wish to
download and click [Image Download].

« Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

« Clicking on different images while holding down the [Ctrl] key selects multiple
images.

& CameraWindow - Canon FF k&

File(F) Edit(E) View(t) Help(H)

P;w N — 2| File Information:

@V Image Download Print Start ZoomBrowser EX

= ) FlleName:  IMG_0101JFG

] 2 Modified: 20001715 14:49.28

File Size: B0KB
Image Gize: Bd0dE0

_# | Histogram,

B Select - =

A blue frame
appears around
the selected image.

IMG_0101JPG IMG_D10ZJPG IMG_0103.JPG IMG_0104.JPG

2| Detail:

Item Name Value A
File Name IMG_010
Camera Model W... Canon
Shooting Dake)Ti... 1§15/200
Shooting Made Portrait
Phote Effect off

Tw (Shutter Speed) 1§40

Aw (Aperture Val... 2.0

L~

Light Metering Evaluativ
Exposure Comp..

150 Speed Auto

Lers 2665
Focal Length 7.9 mm
Digital Zoam Hane
Image Size G480
Image Quality Fne &
< >

Selects image 1 of 4

¥y [Delete] from the [Edit] menu and @ will not be active when transferring the
A stil images recorded on the disc.

3 Confirm the settings and click [Starts Download].
« ZoomBrowser EX starts, and the downloaded images appear in the Main

Window.
CameraWindow - Download Images
|
i — Download images according to the following settings.
Specify Folder
Save to [Folder Mame]
) CADocuments and Settingz\Canoniy Documents
Setting for the folder and the
. Create Sub Folder
subfolder for downloaded images
Shooting 'earkd onthD ate
I Specify File Mame \
Settings for the fiI_e prefix DT e
and the consecutive numbers J
l Change Settings... ]
m [ Cancel ]
\ /

» To make changes, click [Change Settings].
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[Specify Folder] Tab

Cameral¥indow - Change Settings

SpeCIfy the Settings of Specify Folder | Specify File Name |

the folder and subfolder.

Save to [Folder Mame)

|E:\Documents and SettingztCanon'ky Documents | L Browse. . .]

£ subfolder into which the image will be saved will automatically be created in this folder.

Create Subfolder
|Sh00ting YeartdonthDate vl

Meww Mame

Example:

[:. C:ADocuments and SettingzsCanon'by Documents
{2 200%_01_15

ak. ] [ Caticel

[Specify File Name] Tab

CameralWindovr - Change Settings

Specify the file name at ——=mmrrae— Seeciy Fie Name |
which to save the images.

Specify File M arne:

MG

Aizzign S equenc

Hurmber of gt

43

Example

i file = asithe'o

ok, ] ’ Cancel
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B Using a Card Reader/Writer

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For instructions
on how to connect the card reader/writer, please refer to its manual.

29y |f your card reader/writer does not support miniSD cards, please purchase an
& appropriate adapter for the card.

1 Insert a memory card containing images recorded with the
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows
[Start] menu, and select [Programs], [Canon Utilities],
[CameraWindow], [CameraWindowMC] and
[CameraWindow].

Windows XP: When a window appears allowing you to select
an application program to start, select [View/Download
Images using Canon CameraWindow] and click [OK].

2Py Clicking [Acquire & Camera Settings] » [Acquire Images from Memory Card]
‘A in the Task Area of the Main Window of ZoomBrowser EX also opens the
Camera Control window.

3 Select a downloading method.

* [Starts to download images]: The progress bar will be displayed and images
will be downloaded to the computer, and ZoomBrowser EX starts. For
instructions on how to set the Auto-download settings, see Auto-Downloading
Settings ([1] 30).

* [Lets you select and download images]: The CameraWindow opens,
displaying the camcorder images as thumbnails (small images).

$& CameraWindow - G:ADCIM

| Acquire Images | Print
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Using the Camcorder to Download Still Images (Direct
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the camcorder to
download images.

B Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon 3 %% %

Acquire Images | [3rint | Set to Camera | Remate shooting

Downloads uging camera

s \-'-’JQN Press the camera's button

2

Lets you select and download images

Digplays thiz screen when the camera iz connected

| Preferences... |

2 Select [Change direct transfer download destination folder]
and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

(@ Change direct transter download destination folder )

() Change auta download setings

| Cancel

Downloading Still Images (ZoomBrowser EX) I 37



3 Specify the destination folder settings and click [Finish].

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder
A new folder will be created far each of the images' shoating dates in the following faldar,

and the images will be saved there.

C“Ck thlS button Browse...

to Specify the Create Subfolder
destination fOIder. Shioating "earkd onthD ate v
E xamplz:
. 1 C:ADocuments and Settingsi\Canonthdy DocumentssMy Pictures
Select to specify — ) 200k 015
the name of the
subfolder.

< Back Cancel

B Direct Transfer

1 Select a transfer option on the camcorder screen and press
the D~ button.

» See your camcorder instruction manual for how to set and operate the
camcorder to transfer images.

« The [y button cannot be used when it is not lighted.

* You can set the action that is carried out for direct transfer. Right-click the
[CameraWindow(Launcher)] icon on the taskbar and select an action from the
displayed menu.

- [Show image(s) in fullscreen . S
model]; v Show image(s) in fullscreen mode

Displays downloaded images in | .+ Launch ZoomBrowser Ex
full screen mode. —

- [Launch ZoomBrowser EX]: I'v Show Window

Starts ZoomBrowser EX after

downloading the images. Abouk CameratwindaoveLauncher). ..
- [Show Window]:

The Camera Control window Exik

appears when you connect the
camcorder to the computer.

2 Press the [0,~» button on the camcorder.
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| Printing Still Images

Printing Still Iméages Recorded on the Disc or Memory
Card

You can select one of the following 4 methods to print still images in the disc or card
without downloading images to the computer.
* [Print All Photos]

- Prints all still images recorded on a disc or memory card in the connected

camcorder or in a card reader/writer one image per page.
* [Print Contact Sheet with All Photos]

- Prints all still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer in an index (rows of images with file names
and image information).

* [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.
* [Select an image and print]

- A list of the still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer will be displayed, and you can select images
you wish to print.

1 Connect the camcorder to the computer. (11 25)

2 Click the [Print] tab in the Camera Control window.

& CameraWindow - Canon #4434

Acquire Image Etto Camera Eﬂote shooting

Downloads uzing camera

P Q&N Press the camera's button

| Downloads uzing computer

%@ Lets you select and download images

Diizplayz thiz screen when the camera is connected
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3 Click one of the 4 printing methods.

& CameraWindow - Canon sk ok |Z||E|[g|

Acquirelmages| Frint |Set to Camera | Remote shooting.'

~

Print All Photos

)

Print Contact Sheet with All Photos

Print according to DPOF settings

L]
L

Select an image and print

1]
|

W [P [

\ J

Diizplayz thiz screen when the camera is connected

4 Specify the print settings and click [Print].

The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

Frinter Frewview

Name: | ( J‘ @
tJ | TrimImage

Canaon A
| KRR | Fiotate Left  Ratate Righ

Properies...

(MediaType:

|Plain Faper v|

Faper Size: —

|Letter v|

Orientation:

@ Portrait O Landscape
§ ),

Taotal: 4 pages
Fage Layout Settings

Auto Trirn

[ Barderless

Select additional information
to print with your images:

[[] Shoating Date
[[] Shoating Time

Text Color: (|

opies: |1 3_',

4| Image: 1/4 E
=i

Click this button to switch between still images

Sets the auto trim if multiple images are selected.

(crops image edges

according to the page — Sets the number of print copies of the displayed image.
proportions) or

borderless print settings. =—Sets the shooting date/time imprint and color settings.

Printing Still Images I 41



When you have selected [Print Contact Sheet with All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

index rintSetines K

Frinter Sreview

Marne: tu
G v
| el —| Fotate Left Fotate Riaht Trim Image

Properties...

Media Type:

Flain Paper hd

Faper Size:

Letter v

Orientation:
@ Partrait O Landscape

-~

Copies: |1 E

Total: 1 pages

Fage Layout Settings

Colurnns: 3

Fows: 3

48 |4

\_

Shaating Information

[ Header/Footer
\ 4 gas . _— Y
4 Page: 141 »
1 ]
Sets the print settings Click these buttons to switch between pages.

for shooting information,
comments, headers,
footers and page
numbers.

— Sets the number of print copies of the contact sheets.

Sets the number of rows and columns.

When you have selected [Print according to DPOF settings]:

* The selected still images will be printed according to the number of copies set with
the camcorder. The same window described in the previous section When you have
selected [Print All Photos]: ([1]41) will be displayed.
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When you have selected [Select an image and print]:

* If you selected [Select an image and print], the following window will be displayed.
Select still images you wish to print, and click [Print]. If you selected [Contact Sheet
Print], the same window described in the previous section When you have selected
[Print Contact Sheet with All Photos]: ([ 1] 42) will be displayed. If you selected [One
Photo Per Page Print], the same window described in the previous section When you
have selected [Print All Photos]: ([1]41) will be displayed instead. Set the print
settings and print the still images.

& CameraWindow - Canon Ak ok o4 |:| ‘El gl
File(F) Edit{E) Wiew(v) Help{H)

= — s _# | File Infarmatiar:
—;j', Image Downlc (@ @ Print = ﬁ Statt ZoomErowser EX File Mame:  IMG_0101JPG

Modified,  200%/01/1514 4328
= - = =@
e y File Size: BOKE

Image Size:  G40x480

ﬂ Histogram:

IMG_0101JPG IMG_D102.JFG IMG_D103.FG IMG_0104.0FG

5| & Detais:
Trem Mame Yalue A
File: Marme: IMG_010

Camera Model M., Canon s
Shoating DatefTi... 1715200
Shoating Mode Partrait
Fhota Effect Off

Tw (Shutter Speed) 1740

Ay (apertore val,, 2.0

Light Metering Ewaluativ
Exposure Comp... 0O

150 Speed Auko

Lens 2.6 - 65,1
Facal Length 7.9 mm
Digital Zoam Mone
Image Size E40x480
Image Cuality Fine v

4 >
"Selects image 1 of 4
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Printing Still Images Downloaded to the Computer

You can select one of the following 2 methods to print still images downloaded to the
computer.
* [One Photo per Page Print]
- Prints one still image per page.
* [Index Print]
- Prints selected images in rows with file names and image information.

2Py You can select the program to use for printing by clicking [Print] in the Main
7 . . . .
Window and selecting [Print Using Other Software].

B [One Photo per Page Print]

1 Click [Print] in the Main Window and click [One Photo per
Page Print].

17 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures
File Edit View Tools Internet Help

[ Tasks a ] @ Slide Show {a Search

M Acquire & Camera 5 ettings Zoom Mode | Serol Mode | Preview Mode

F?— . . My Pictures € > 2 [} -0~ |li(§\‘\ Jr—-"'" .]:?:: Filter T ool
¥ Wiew & Clazsify |

5 200£_01_15

MG DIDMG 0102.)

[ N
N

ﬂI .

' N

- )

| One Photo per Page Print

Indesx Prink

Frint Using Other Software

l Intemet

2 Select still images you wish to print and click [Printer and
Layout Settings].

i1 ZoomBrowser BX - C:\Documents and Settings\Canon\My Documentsiy Pictures

Help

Zaom Mode | Serol Mode | Preview Mode -
o™ € >4 |H-0-[R L [ FiterToal

¥ 200%_01_15
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3 specify the print settings and click [Print].

Sets the paper size and orientation. Rotates still images.

Selects the printer. Click this to use the trimming function

(crops a portion of the still image).

=1 ZoomBrowser, EX - C:\Documents and|SettingsiCan |._”i”£|
File Edit Wiew Tools Internet Help

-
k"é One Photo per Page Print

1. Select Images Frinter

Marme:

Printer and Lavout Settings \@
‘ | 3. Print > [W

Fotate Left  Rotate Right

Media Type:

Flain Paper V‘

Paper Size:

Lettar A
| 9 Retun to Main Menu ‘

Orientation:

@ Farrait O Landscape

Taotal: 4 pages

Fage Layout Seftings

Auto Trim
[ Barderless

Select additional information
to print with your images:

] Shooting Date
] Shooting Time

TextCalor: [N

Copies:

4 Image: 174 »

Click this button to switch between still
images if multiple images are selected.

Sets the number of print copies of the displayed image.

Sets the shooting date/time imprint and color settings.

Sets the auto trim (crops image edges according to the page proportions) or borderless
print settings.
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B [Index Print]

1 Click [Print] in the Main Window and click [Index Print].

&1 ZoomBrowser B4 - C:\Documents and SettingsiCanoniy Documentsiby Pictures

File Edit View Tools Internet Help

[ Tasks 6] '— Yiew Image

Acquire & Camera Settings ]

@ View & Classity ]
[@ Edit ]
1@ Export ]
\% Print ]
Lﬂne Photo per Page Print J
— —

|

25 properties @S\ide Shiaw @ Search || Delete R Raotate

Zoom Mode | Seroll Made | Preview Made|

My Pictures L2 *~ @ -0 - |I|®§ = j—‘ 4,? Filter Tl

=
| Index Print
T

rPnnt Using Other Software

A2 < IMG_0103. PG IMG_0104.0PG
l Interet ] - -

2 Select the still images you wish to print and click [Printer
and Layout Settings].

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documentsiy Pictures

File Edit Wiew Tools Internet Help

Zoom Mode | Scroll Mode ‘i.-ll-;review Mode|
Select Images :

= My Pictures
| 2 Printer and Layout Settings
— ¥ 200%_01_1

J

J

]

3 Print T
3 Retum to Main Menu ﬂ

|h
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Specify the print settings and click [Print].

Sets the paper size and orientation. — Rotates still images.

Selects the printer.

Click this to use the trimming function
(crops a portion of the still image).

w1 ZoomBrowser EX - C:\Documents and Settings\Can |;HEHE|

File Edit Wiew Tools Internet Help

ndex Print 2  Printer and L et Help

‘ 1. Select Images | Frintar
MName

; i B ]

l Printer and Lavout Settings ‘ [Canon s 3

CEE—
Media Type:

Flain Paper V‘

Faper Size

Letter b
| 99 Retun to Main Men.

Orientation:

@ Ponrait O Landscape

opies iT s

Taotal: 1 pages

Pane Layvout Seflings

(Culumna 3 ;I
kRDWS ‘3 :!

Shaoating Infarmation

Setlings..

[ Header/Foaoter

| 41 Page: 1/1

b

Click these buttons to switch between pages.

Sets the print settings for shooting information, comments, headers, footers and
page numbers.

Sets the number of rows and columns.

Sets the number of print copies of the contact sheets.
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| Organizing Images

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars. The
Star Rating can be used as one of the search conditions, or for the selection of images
to be displayed in the Browser Window. The keyword can be used as one of the
search conditions.

1 Select the image to which you wish to apply the Star Rating
or Keyword, and select [View/Modify Keywords] from the
[Tools] menu.

e =8 Inkernet  Help

Search.

_ustomize. ..

|_ Preferences...

2 Place a check mark next to the keyword you wish to apply,
or click on the stars for rating.

o7 View/Modify Keywonds

Check or uncheck the bawes to change the way Kepwards are applied to the selected files. To add a new Kepword. type the name in the
text field belows the desired categary, and press the + buttan.
People: Flaces: Events: Others: )
[ Children [ Beach [ Bithday
] Family [ Citw [ Haliday
[ Friends |\:|H0me [ Party
— J
Select the star rating to assign to the selected files
Cancel

2Py © The default setting of the Star Rating is two stars.
4 © You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures

File Edit View Tools Internet Help

[Tasks 0| B e [B] vt @S\ide Show @ Search Delete [ Robste

t@ Acquire & Camera Settings J Zoom Made | Scroll Mode | Preview Mode | .
= —_— — My Pictures < ﬁ m 5 0 a2 |Ll@l7 % J-_ 4,? Filter T ool

( F} View 3 Classily

N

=
@~ | [k
@ | S

2 Click [Classify into Folder].

17 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiby Pictures \'L\['E|fg|
File Edit View Tools Internet Help

[ Tasks a ] D? Slide Show @ Search
@ Acquire & Camera Settings

| (=
Eé} Wiews & Clagsify

¥ 200%_01_15

MG_0101.0PG  IMG_D102.0PG

Zoom Made | Scroll Mode | Preview Mode |

by Pictures < + m - - |L|@'&7 J—-—-‘""' 4,? Filter Tonl
Wiew gt a Slide Show

|

% ¥ 200_01_15 ,
Lﬂeﬂame Mulliple Files J

|

B
e e —— al

=
|
rSeamh 7

3 Select the images you wish to classify and click [Specify
Classification Settings].

#7 ZoomBrowser EX - C:\Documents and Settings\Canoniy Documents\y Pictures

ST

Zoom Mode | Seroll Mode

hy Pictures < + m -0 - |E|@'&7 J—-—-"‘"' 4,? Filter Tonl

Select Images

= Y—m =

| 2 Specily Classification Settings |
S

e ——
I: Firizh TI

™

[ 3 Retun to Main Menu
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

7 ZoomBrowser, BX - C:\Documents and SettingsiCanoniMy Documents

File Edit WView Tools Internet Help

into Folder

{ 1. SelectImages l ? fecify Folder Structure When classifying by shooting \
date, ZoomBrowser Exwill anly

S folder struct
I_'?J REEHCIdonEcn e classify photos with shooting

Specily Classification Settings
P ‘YearMnthate V| dlate information and skip over
- ‘Ej photos without shooting date
. Example Folder Structure: information.
] E} ‘ = CADocuments and SettingsiCanoniiy Documents |
200%_01_15 By default, ZoomBrowser Ex
- copies the ariginal photos to the
nes folders, To save space on
wour computer. choose to move
1 Return to Main Meru [eRioesized
Sewve ta Folder
o ‘Where would you like these folders to be created?

‘:ZJ © Current Folder
EJ O My Pictures

O Specify Folder

.C.\Ducumeﬂls and Seﬂi‘ngs\CanUn\M‘y D‘Ucumems

Copy or Mowve Images

@ Copy

Q%T | OMove /
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and copy

multiple files.

1 click [View & Classify] in the Main Window.

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit Wiew Tools Internet Help

— = =
[ Tasks 6] Wievs Image (=2| Properties @ Slide Show @ Search Delete ¥ Rotate
L PEniol Conm St J Zoom Mode | Serall Mode | Preview Mode |
rT',‘E?-"? My Pictures + 4+ m -0 |i| }—-"‘ .]:?:: Filter T ool
\r Wiew & Clazsify
N 4

I o
=
@~

l Initeret

2 Click [Rename Multiple Files].

MG_0101.0PG  IMG_D102.0PG

7 ¥ 200¢_01_15
|

|

|

17 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures

File Edit View Tools Internet Help

DF Slide Show @ Search

Zoam Made | Soml Mode | Preview Mode

[ Tasks

@ Acquire & Camera Settings

r_} Wiew & Clazsify ]
iew a5 & Shide Shiow J
~

|

My Pictures €

¥ 200%_01_15

=

S
—— |4

.r

-
|
™

Rename Multiple Files

Claszify into Folder

Search ]

3 Select the images you wish to rename and click [Specify

Rename Settings].

7 ZoomBrowser, EX - C:\Documents and Settings\Canoniiy Documentsiby Pictures
File Edit Wiew Tools Internet Help

STEF1: Select Images

Zoam Made | Sorl Mode ".Preview Mode

4@ 0%

J»—-—f" ,f?:ﬂ Filter Tl

Jr—-f" ,f?:ﬂ Filter Tl

= e — = My Pictures +
| 2 Specily Rename Settings )
C Rl . V4
—— Wﬁux_uu 5
Y R —

J 3 Return to Main Menu

Organizing Images I 51



52

4 specify the settings and click [Finish].

&7 ZoomBrowser EX - C:\Documents and SettingsiCanonty Documents

File Edit Wiew Tools Internst Help

ﬁ, Rename

ultiple Files

‘ 1. SelectImages | Rename Settings Rienaming your photos can
Select how files should be renamed. make saarching for tham much
Specily Rename 5 ettings easier.
= @ New Name + Number

O Shooting Date + Number
O Mew MName + Shaoting Date + Nurber 123.0PG 456.JPG
O Shooting Date + New Name + Number

7] Make copies of files

A_N0TJPG  A_DD2JPG

—

f'|i'1

Specity narme: |HEWHAME

By cefault. ZoomBrawser EX
MNumber of digits: 3 crestes and renames copies of
- the original photos. To sawve
SPACE 0N your computer,
choose to rename the original
photos instead.

[ 9 Retun to Main Mefu

Start number. |1

Example of new file name:

MEWNAME_N01 0
\ MOTE: The original data type (o0 will be retained /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

v To rename a folder, select a folder, and open the [Rename Folder] window by
(&7

selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images
This task allows you to search for images by Star Rating, Modification Date, Shooting
Date, Comment or Keywords.

1 click [View & Classify] in the Main Window.

You can also search for images by clicking [Search] on Application Tool Bar.
Please skip forward to step 3.

1 ZoomBrowser EX - C:ADocuments and) SettingsiCanonikly Documents\My Pictures
1=

File Edit Wiew Tools Internet Help

[ Tasks

t@ Acquire & Camera Settings
= e —

,5 ?) Slide Shuwl ".Q Search '

J | ZoomMode | Seroll Modz || Preview Mods
My Pictures

— N € 4 | [} 2 (i)w ‘j,i(ﬁa _J-—)""‘ .f:f Filter Taal

U= wiew & Classify

D 1

r@ " ‘I 3 200%_01_15

i
l@ Expart | < -~
r o

l@ Frint | ‘ 4

l e l IMG_0101.PG  IMG_0102.JPG

2 Select folders and images from which you wish to search
and click [Search].

¥ ZoomBrowser, EX - C:ADocuments and SettingsiCanony Documentsidy Pictures

File Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings

=
L’f@_ Wiew & Classity

Praperties ,rj?? Slide: Show [@ Search ﬁ Delete %

Zoom Mode | Scrall Made | Preview Mode|

« > 2 |H0- ] QA

| T Fiter Tool

Wiew gt a Slide Show

|
|

|

.

Clazzify into Folder
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3 Specify the search conditions and click [Start Search].
* The search results are displayed as thumbnails.
* Select at least one search condition.

&7 ZoomBrowser, EX - C:\Documents and SettingsiCanonthy Documents

Fille Edit Wiew Tools Internst Help

1. Selsct Search Region

’ @ Match all conditions O Match any condition ‘

Specify Search Conditions

l 3 StartSearch

| 99 Retun tobain Meru

@\X

4 Click [Finish].

STEP 2: Specify the search conditions

Help
-

Star Rating

Find irmages with the selectad star rating

[ Modification Date

Find images based on the date they were last modified

[ szziz005_ ~]
O sizgznns_ ~]

[] Shooting Date

Find images based on the date they were shot.

O srzzr200s_ ~]
[ sizgrz0s_~]

[J Camment

Find images that hawe comments containing the following words:

i<

[ Keywords
\ Find images you have tagged with keywords. /

» To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

" ZoomBrowser B% - C:¥Wocuments and Settings\Canony Documents

i

Select Search Region

Help

2. Specify Search Conditions

L Stant Search
=

D
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* The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder.

Favarite Folders
=¥ My Pichures

¥ 200%_01_15
—

brlaln LR uk MR B

Folders Area

[ 1

oys The searched images will remain in this folder until ZoomBrowser EX is closed
4 or another search is performed, but if you delete an image in this folder, the
corresponding original image will be deleted as well.
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| Creating a Movie from the Still Images

Editing Movies

You can link still images, insert text and background music, and add effects. You can
also change the size of selected movies and save them as new files.

VG‘ o If you are not using Windows XP, QuickTime 6.5 or higher is required to edit
\ o/ movies. If it is not already installed on your computer, install it from the
DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.
o If you have an AVI file in your computer, you can use this function to edit the
file.

1 Click [Edit] in the Main Window.

1 ZoomBrowser B - C:ADocuments and SettingsACanon\My DocumentsWiy Pictures

File Edit Wiew Tools Internet Help

[ Tasks

@Aq & & Camera Settings

‘f'- Wiew & Clazsify

Q]
|
, d
G- >
o= ]
&~ |
e |

2 Click [Edit Movie].

¥ ZoomBrowser, BX - C:ADocuments and SettingsiCanoniMy Documentsiiy Pictures

= .
3 ,7? Slide Show “a Search

Zoom Made | Scrall Made | Preview Mode .
My Pictures .3 f.’ R-0- \ .@w‘. _}——-——“ ,f?:ﬂ Filter Taal

200 _20

FII Tﬁ
,_.J

IMG_0107, JM 0108,

File Edit View Tools Internet Help

= » ~ B
[ Tasks ] ;l Yiew I operties (3] ] Slide Show “a Search clete
@ Acquire aieE ol h Zoom Mode | Seroll Mode | Preview Mode N
G @ =
My Pictures € 4 T - o- | Y o Filter Tool
= || “a B
I Wiew & Clazsify
\@ cal |
Edltlmage J
N
\ Edit Movie )
| IMG_0107 JPG  IMG_0108.0PG
E wport
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Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures
File Edit View Tools Internet Help

@ Edit Movia STEP 1: Add images. Help

Add Images 2ok Zoom Mode | Scroll Mode | Preview Mode | .
— —_— My Pictures & 4 m -0 - |L|Q a = [W
1 2 Arange > J
—|E 200_01_20

3. Apply Effect

4. SetAudio

\ 5 Save l
bl

Arrange images and click [Apply Effect].
To change the order of images, select an image in the Storyboard Area and click
[Move Left] or [Move Right].

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documents

File Edit Wiew Tools Internet Help

Edit Maowvie STEF 2: Arrange images.

Arrange i

To arrange images. select the image and click on the [Move Left] ar [Move Right]
buttons.

7 | Move Left ] [ Mowve Right ]
{3 ApplyElfect =l . %
- L —— To et the play time or ratation, select the image and click the buttan,

[ Play Time ] [ Hotate J

3 Return to Main Menu

Total Time: 00:10

Selected Items: 2

Plays back the movies Storyboard Area

being edited. Displays thumbnails of the
selected images. The images will
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.
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5 Apply effects to the images and click [Set Audio].
When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text,
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.

- [Transition Effect]: Opens the [Transition Effect Settings] window. You can
set the transition effect type and display time, and preview the effect. To set
a transition effect, you need to select a transition box in the Storyboard Area.

1" ZoomBrowser B% - C:\ocuments and SettingsiCanony Documents

File: Tools  Intermet  Help

0t : =~ 3 .
B" Aovie 5 effects to images

=)

Image Effects

\ 1. AddImages D lse imane as is

® Anp\y effects to image.

2. Arange ] {A@@ To et the Tekt effect, Filter effect. or to magnity a section. select the image and click the
appiopriate button
L Apply Effect J b ] [ ] [ - ]
~
|

Tent Effect Filter Effect I agrify Section

=
\ 4 SetAudio “wihen you want to set the image's Transition effect, sslect the [Transition Effect] box and
_4 click the [Transition E ffect] buttan,

5 Save

Q|

B Euit ]

6 Set the audio and click [Save].
When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add a MP3 or a WAV
file as background music.

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can
adjust the audio level of a movie or an audio file and apply audio faders. To
set the advanced audio settings, you need to select a movie or an audio file
which you added.

'rT ZoomBrowser EX - C:\Documents and SettingsdCanoniy Documents

Fil= Edit View Tools Internet Help

P
| '5_;_'5 Edit Movie Set audia.
1. AddImages 1] et [T [ S
(%) Set audio.
\ 2. Arange h Tao add audio, click the [£dd Audio] buttan
S ABE ==
\ 3 Apriy Efect ‘ = Ed fudic
L Set Audio J To set advanced audio zettings, select [Audio] and click the [4dvanced Settingz] buttan,

- ~
Advanced Settings
L —
Exit 7

[ = ]
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Click [Save].
Movies are saved in DCF type files with Motion JPEG/AVI compression.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniiy Documents

File Edit Wiew Tools Internst Help

Edit Mowvie clit results.
Save file
1. AddImages i
2. Amange A
= Save to folder:
3 Appl Effect |C:\Documants and Settings\Canoniky Documents | [ Browse
Save !
4 Sethudio Bl

%) Auto-select
() Specily a save image type

[ Gave |
- |

Advanced Settings | e——————

Save image tpe:Motion]PEG (Y]]
Image Size:320 » 240 [Standard]
Frame Rate:15 Frames/second
Audio: 16 bit, 22 050 kHz, Monaural
Total Time: 00:10

Click [Save] buttan ta save the edit results,

Y=o
I 3 Retum to Main Menu I

Select this to save as Motion JPEG compressed AVI.

Selecting [Specify a save image type] and clicking [Advanced Settings] allows
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.

Click [Exit].

7' ZoomBrowser, EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

Save file
1. AddImages

l File ramne: |
‘ 2 Amange | “ i

| Save to folder

3 ApalyEffect |E'\Dncumenls and Settings\Canoniky Documents | [ Browse ] |

: Save image tupe Lk
4. Setdudio () Auto-select

() Specify a save image lype

JotionIPER fe:1 >

Advanced Settings

Save image tyne:Mation  FEG 241]
Image Size:320 % 240 [Standard]
Frame Fiate:15 Frames/'second

T

udic: 16 bit, 22,050 kHz, Monaural
otal Time: 00:10

Click [Save] button to zave the edit results.

Save

I Return to Main Menu

Creating a Movie from the Still Images 59



Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first scene as
a still image with a (movie) icon.

2% © If you are not using Windows XP and QuickTime 6.5 or higher is not already
& installed on your computer, install QuickTime 6.5 from the DIGITAL VIDEO
SOLUTION DISK.

0 Do not double-click a movie file (.AVI extension) in Windows Explorer. That
will start Windows Media Player, which may not support this file type. To play
back movies, double-click the thumbnail with a movie icon in the Main
Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a
(movie) icon.
[Image Viewer] window appears.

t7' ZoomBrowser BX - G:\Documents and Settings\Canon\My Documentsiy Pictures
File Edit View Toaols Internet Help

= i @

[ Tasks ] 3 1/ Slide Show “a Search

@ I caliie bl Eamerals ctigs ] Zoom Mode | Scroll Mode | Preview Mode § i

— My Pictures < t R-0-|[ k& S Filker Tool
= . = N

¥ Wiew & Clazsify

0

& |
[T Export ] I
[% Print ]
{@ Irtermet ]

Favarite Folders | All Folders

Last Acquied Images ] "N

= All Tmages %

= & Shooting Date < | ! IM% IMG_D104. PG
[ snmy m o |
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The [Image Viewer] window is displayed, and the movie will be played back.
You can control (Play back/Stop/FF/RW) the movie being played back with the
buttons shown at the left bottom of the window. If you are using Windows XP,
you can extract still images from the movie. For details, please refer to
Extracting Still Images from Movies (Windows XP Only) ([ ] 69).

You can save the displayed scene as a still image.

=] ZoomBrowser, EX - C:3Documents and|SettingsiCanoniby DocumentsiMVl_0106.A¥I
File Edit “iew Help

® M Q‘%_‘Ej B3] et - Show: |E|E IO =

You can play movies and control the sound volume.
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| Exporting Images

You can change the data type for selected still images and movies and save them as
new files. You can also export selected movies and still image properties to a text file
or copy and rename movies and still images. Furthermore, you can export still images
for use as a screen saver or a wallpaper.

Changing the File Type and Save

1 Click [Export] in the Main Window.

&7 ZoomBrowser BX - C:\Documents and Settings\Canon\My Documentsiy Pictures

Fil= Edit View Tools Internet Help

= =
3 ?7 Slide Shaw Q Search

s J
[% Aequire & Camera Settings ] Zoom Mode | Serall Mode | Preview Mode - )
= My Pictures R-0- | & |& _J‘“Ff_ 4,? Filter Taal
l }&_ Wiews & Classity ]
J ¥ 200¢_01_15
<
)

IMG_0101.0PG  IMG_0102.0FG

2 Select the export type.
If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], please refer to the pages listed below.
[Export Movies]: Exporting Movies ([1] 66)
[Extract frames from a movie]: Extracting Still Images from Movies (Windows
XP Only) (11 69)
[Backup to CD]: Saving on CD-R/RW Disks (Windows XP Only) ([1172)

7. ZoomBrowser, BX - C:\Documents and Settings\Canoniy Docume ntsidy Pictures

Fil= Edit View Tools Internet Help

[ Tasks 6 ] | Tew Image 5 @? Slide: Show @ Search
\@ Edit
@ Export

Export Still Images

Zol DmM de ScroIIMode Preview Mode

My Picturss G-0- |k '-i"\ J{,—~ 4,? Filter Taal

H F/’

Export Movies

Extract frames from a movie

IMG_0101.JFG  IMG_0102.JFG

Export Shooting Properties

Export a5 a Screen Saver

Export a3 a‘Wallpaper

Backup to COv

\L

[ P
[ Intemet

20064_01_20

_\_—'—'—'—'—'—J_'—)

5

~
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3 Select images and click [Specify Export Settings].

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

Zoom Made | Scroll Mode | Preview Mode |
Select Images

?/ \'\ My Pictures € + m -0- |l|@ % }— 4,? Filter Taal

< 2. Specify Export Settings
> T
- | ¥ 200%_01_15
| 3. Finigh

NS

IMG_0101, JPG [ (i e nh ez

|9 Retunto Main benu | ﬁ e e n
4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step2.

When you have selected [Export Still Images]:

You can convert still images to another file type, resize and save them as new files.
You can select the file type from BMP, JPEG and TIFF. You can also specify a prefix to
be added to the exported still images.

#7 ZoomBrowser EX - C:ADocuments and Settings\Canoniiy Documents

File Edit Wiew Tools Internet Help

@ Export Still Images

‘ Image Settings You can reduce the amount of

‘ 1. Select Images

[ Resize images during export memuryyoL_Jrhles UEE 5y
Specify Export Settings ) resizing the images to a smaller
L J ng < size
il
N 7 L EI 800 | pixels
l—l
Shortgide:
4
= o) -
el
| [ 1 Rieturn to Main Manu [0 Change image type When exporting images as
e JPEGs, vou can also reduce file
fal™ | o ) el sizes by using a lower Quality
sefting which compresses the
Qriginal File Size: 52.8KB image more. The images won't

Modifiad Fils 5 08 KR look as sharp but the file sizes

will be smaller.

File Name Settings
(819 [ Add a prefix Gl

Sawveto Faolder

& Current Folder
ﬁ“/l 8] Ity Pictures

O Specify Folder

Q\Dncuments and Settings\CanonihMy Documents /
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniky Documents

File Edit Wiew Tools Internst Help

Export Setlings

Shooting properties are stored
inimages as EXIF infarmation.

Select Images

Select shooting properties to export:

Active AF Poinls

[¥] AF Mode

AF Range Mode
utnexposure Bracketing
o/ Aperture Value )

Specify Export Settings

EXIF stands for Exchangeahle
Image File Format and is used
by most camera manufacturers

p recard of

Digital Exposure Compensation
[v] Dinital Znnm hd

[ Selectal |[  cClearal |

9 Retumn to Main M
clumn to Main Menu —

Specity file name and folder:

'/! |C\Ducumems and SettingshCan..\ZBShootingPropedies. <t

MNOTE: Properies will be saved as *ixt

Files without shooting properies will not he exported /

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

& ZoomBrowser EX - C:\Documents and SettingsiCanonthy Documents
Fle Edit View Tools Intemet Help

Screen Saver Seftings - The order in which you select

photos determines their

‘ 1. Gelect Images

L Specily Export Settings J
=

[ Include images in the screen saver (larger file size)

sequence inthe screen saver.

7~ x7E8 If you selected to include
images in the screen sawver, you
= = i dluce their size to fit
Screen saver size 0kB Calculate can reduce their size tofita

different screen resolution
[JSetas default screen saver
If wou choose not to include
J images in the screen sawver, and
you then mowve ar rename these
images, they will not display
when the screen saver plays

[ Preview Screen Sawver...

1 Return ta Main Menu

The screen saver will be saved as

Save taFile
(& "ZhScreenSaver.scr' in the default Windows directony for

E SCIeEn savers

O Specify file name and falder " Saueis

wTE The screen saver will be saved using the file extension * scr /
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When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

= ZoomBrowser EX - C:\Documents and) Settings\CanoniWy Documents
Fle Edit View Tools Intemet Help

@ Exportas aper STER fy the export settings Help

1. Select Images | ( Installation Settings Stretching small photos can \

pixelate and distort the photo

Specify Export Settings @ Install centared Try choosing Install centered or
— e — Installed tiled
>~ —_— ~
< s / O Install stretched Tiling replicates the phota. in its

-

original size. to fitthe deskiop.

create a g O Install tiled

O Do notinstall

The wallpaperwill be saved as:

| 9 Return ta Main Meru %__‘
VJ

@ "ZBWallpaperbmp" in the default directary for wallpapers

O Specify file name and folder

\NOTE Wallpapers are saved as hitmap images (*hmp) /

Exporting Images 65



Exporting Movies
You can change the size or data for selected movies and save them as new files.

@ If you are not using Windows XP, QuickTime 6.5 or higher is required to export

\&¥4 movies. If it is not already installed on your computer, install it from the
DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click QuickTime 6.5 [Install] in the installer panel.

1 Click [Export] in the Main Window.

17 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documentsiy Pictures

File Edit View Toaols Internet Help

[ Tacks [z} @ Slide Show ‘Q Search

@ Acquire & Camera 5ettings — — = o
= My Pictures + t FR-0- | K |"!¥ Jr—"" .]:?:: Filter Taal
=R . = i J

I iew & Clagsify [

|
Nt
L@ o J : 200 _20 = |

i Zoam Made ;_Scroll Mode | Preview Mode|

MG_0107.0PG  IMG_D108.0PG

l Internet

| B Gl T E e |

2 Click [Export Movies].

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit Wiew Tools Internet Help

[ Tasks 6 ] D? Slide Show @ Search Sﬂ DEle " Ru
\@ Edi l” | Zoom Mode fScroIIMode Freview Mode | A

[ My Picturss £ A @ -0 - .lil@‘ it 4,? Filter Taal
ﬂ@ Export SN0 s B - .

LExpDrl Still Images

Export Movies

I/ \l

Extract frames from a movie

Export Shooting Properties

Export &z a Screen Saver

Export as a ‘Wallpaper

Backup to COv

L L 1 Gl WA | |
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Select a movie and click [Select the save image type].
You can select multiple images or a folder to include all images in that folder.

Still images cannot be selected. For instructions on how to export still images,
see Exporting Images ([ ] 62).

&1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy DocumentsiMy Pictures

File Edit View Tools Internet Help

@ Export Mavies

Zoam Mode
Select Movies Scroll Mode H Freview Mndel

! e 3 My Pictures * + m -0 - |l|@ % }‘ J,? Filter Taal
{ 2 Select the save image tvpe D
—_——— 200H_01_20
F Set the save image type 7

\ 4. Specify name of file to be saved ]
\ B Start export ] ;

IMG_0107 PG IMG_0108.JPG
[ 3 Retun to Main Menu ] H
(= O

Select a file type and click [Set the save image typel].

&1 ZoomBrowsen EX - C:\Documents and SettingsiCanoniMy Documents
Fil= Edit View Tools Internet Help

Select Movies

Select the save image type J |MD“°NPEG () ﬁ'
> ~ Standard maovie f_\le usad_ oh computers. .
€l 5o image e ) 'V'ou can set the image size, frame rate and image quality
in the next step,
D —( |
F Specify name of fils to be saved 7

5 Start expart

Save image type

' 1

Rotation settings -

- [] Ratate
' 1 80 degiees l=ft
S0 degre== righ!

180 degre=s

l 3 Retun ta Main Menu ]
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68

7 Click [OK].

5 Specify the export settings and click [Specify name of file to

be saved].

w7 ZoomBrowser EX - C:\Dpcuments and SettingsiCanoniy Doc uments

File Edit View Tools Internet Help

. E—Fﬁ Export Movies

- a )
1. Select Movies ﬂnage Size \

(%) No change
2. Select the save image twpe () Zoom specification 50 %
z () Size specification 320x 240
Set the save image type

Fix the aspect ratio

{ 4. Specify name of file to be saved )

Frame Rate
- - =
5. Start expart
Image Quality
=
: Y
Lo Standard High
Audio
Automatic b
l 3 Retumn ta Main Menu ] \ )

6 Specify the file name and click [Start export].

In each case, specify the destination folder and file name of the movie to be
exported.

7 ZoomBrowser BX - C:ADocuments and SettingsiCanony Documents

File Edit View Tools Internet Help

narne offile to be

\ 1. Select Movies File Mame setting

(%) Same a3 original image

\ 2 Select the save image type () Assign Sequence No.

abc |

\ 3. Setthe save image bype

L Specify name of file to be J
saved

~

P

Save to folder . -

|E' SDacuments and Settings\Canonhy Documents [ Browse

[Save image twpe information]

Save image lwpe:Motion PEG [&41]
= Image Size:Mo change

Frame R atesiutornatic

Image Quality Standard

Andio:Autornatic

I Retumnto Main Menu

Destination Folder

The Main Window appears.

MovieExport Task

Export is completed.

@ Details ==
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Extracting Still Images from Movies (Windows XP Only)

You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window.

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures
Fil= Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings Zoom Made | Scroll Mode | Preview Mode | .
My Pictures + + m -0 - |L|Q ! J-_ 4,? Filter Taol
@ Wiew & Classify

8]
%
£ il

—_—— —— -
( @ Export ‘
~NY o)

 E—

== .
ViewImage  |=7) Properties @Shde Shiow @ Search Delete ] Rotate

IMG_0107 PG IMG_0108.0FG

TS
\ Intemet

E' =

2 Click [Extract frames from a movie].

1 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documentsiy Pictures
File Edit View Tools Internet Help

[ Tasks 6 ] @ Slide: Show @ Search
\ z Edit lﬁ  Zoom Mode [ Scroll Mode | Preview Mode |

My Pictures € 2 B0 xR e [ T FiterTool |
[@ Export l
|
)

200k_0_20

E=port Still Images

Ekpart Movies J

—
—(
Export Shooting Properties 7

Export a5 a Screen Saver

Export a3 a‘Wallpaper

[ 200%_01_25

=
i
i

3 Select the movie from which you wish to extract still images
and click [Set extraction method].

|
J
Backup to CO l
J
|

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures
File Edit View Tools Internet Help

' Zoom Moge | 5 croll Mode | Preview bode |

My Fictures + 4 K-0- IEI'L‘I e [ P Fiter ool

2I]EI><_I]‘[_\2I]

IMG_D107, PG IMG_0108.0PG

Preview image

4. Setupsave

Perform processing

IMG_0109.0PG  [IRGH

| 9 Retum to Main Menu
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Select the still images extraction method and click [Preview
image].

* [Extract all frames]: Extracts all frames in the movie as still images.

* [Specify an interval and extract frames]: Extracts frames as still images from a
specified frame range or time interval.

* [Specify the number of copies and extract frames]: Extracts a specified
number of still images from the entire movie. The extraction interval is
calculated based on an equal distribution of the specified number of still
images.

* [Extract a specified image]: Extracts still images from scenes that catch your
attention.

{7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

Help

File: name:k1_0108.441
Play time:00:07.00
Tokal frames:105
Image Size: 320«240

/ Select how to extract the still images fram the movie. \
(&) Extract all frames
N Extracts everp frame in the movie as a still image.
"'-‘;._'_ﬁ
N

() Specify an interval and extract frames
<N Specifies the interval at which stil images are extracted from the movie.

Preview image

1 —_—
F Set up save

5 Perform processing

=\ J
g.;

L J
) Specify the number of copies and sxtract frames

9 Retuinto Main Manu Specifies the number of copies of still mages to be extracted from the movie
E’ 11 Copies
wiract a specified image
() Extract a specified imag
l_| o Extracts the frame you select while watching a previews of the movie as a il
=

~ imane.
\ J/

|
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Confirm the still images which will be extracted (images with
checkmarks) and click [Set up save].
If you selected [Extract a specified image] in the previous window, the movie will

be displayed in the upper part of the window. Display the images you want and
click [Add].

w7 ZoomBrowser EX. - C:\Documents and SettingsiCanoniMy Documents

it Wiew Tools Internet  Help

Help

1. Select movie

p | File name:MYI_0108 44|
2. Set extraction method - | Play tire:00:07.00

Total frames: 105

Image Size:320:240
—
]

Preview image

N

=

Setup save

8. Perform processing

Checked: 105 / Shown: 105

[ 3 Retum to Main Menu ]

@ » : Changes the thumbnail size.
% - : Rotates all still images.

7 f o il
A i - Clears or adds check marks to all still images at once.

il i : Clears the check marks of all the still images before/after the
selected still images.

Specify the file name and the folder where you wish to save
it and click [Perform processing].

7 ZoomBrowser, EX - C:\Documents and Settings\Canoniy Documents

Help

/F ile Marnz \
) Use original movie file name

| @b@ ) Specify a file name

1. Select movie

‘ 2. Setextraction method

1 3. Preview image

|
T

=

| 5 Perfarm processing D

\ P — 7
{ ou setup how

Save folder

) Save in same folder az onginal movie
=1 O Specify the save folder
Ly |
Erowse

ALt folder creation

(&) Automatically create a foldsr with the same name as the original movie

Gpec\fy folder name for auto creation J

<5Save Contents>
l 1 Retumn to Main Menu I Saved images 105

Image Size: 320:240
Fiequired disk space:dpprox. 2.8MB
Save to folder:C:5\Documents and SettingsiCanoniMy Documentsh200=_01_ 20510106
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Saving on CD-R/RW Disks (Windows XP Only)

You can copy and save images to CD-R or CD-RW disks. The shooting information is
copied along with the images.

’0\ This function can only be used on a computer that came with a CD-R/RW drive
\&¥/ as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-R/RW drive.

2 If the following window appears, click [Cancel].

CD Drive (F:)

Windows can perform the same action each time pou insert
a disk or connect a device with this kind of fils:

(5] Blank CD
what do pou want Windows to do?

CD fiolder|
5 Expl

3 Click [Export] in the Main Window.

¥ ZoomBrowser, X - C:ADocuments and SettingsiCanonMy Documentsiiy Pictures

File Edit View Tools Internet Help

i . =T - ~

[ Tasks o View 1 RertiEs (3] ?? Slide: Show a Search Elete

@ Acquire aiE i | Zoom Mode | Soroll Mode | Preview Mode . il . A
My Pictures 7 4 m L R I8 J,———“'_ 4,? Filter Taal

=
‘,}&_' Wiew & Classity
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Click [Backup to CD].

1 ZoomBrowser EX - C:\Documents and SettingsiCanoniy DocumentsiMy Pictures

File Edit Wiew Tools Internet Help

[

|
|

6 ] | View Image Froperties @S\ide Show @ Search || Delete ‘ Rotate

Tasks
@ Edit e Zoom Mode | Serall Mode | Preview Mode |

My Picturss € t | E-0- |I|Q CF J-_ JFF Filter Taol

@: "21’1'0&_\51-1%?1’5"

Export

[ Export Still Images
[ Export Movies

Extract frames from a movie

Export Shooting Properties

Export &z a Screen Saver

Ekpart a3 a'Wallpaper J i j
7 —: < IMG_0103.PG  IMG_0104.0PG
@~ |

Select the folders or images you wish to save and click
[Specify Backup Settings].

2006 01_20

Fil= Edit View Tools Internet Help
o

ZoomMode | Scrall Mode | Preview Mode|
My Pictures * > ﬁ = 0, “f | k Q }-ﬂ 4,? Filter Tanl

3] 200%_01_15

3. Start Backup

[ 3 Retunto Main Menu ) JEH
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6 Set the backup settings and click [Start Backup].

The disk will be ejected from the drive when copying is complete.

& ZoomBrowsern EX - C:\Documents and Settings\CanonkMy Documents

f Backup Setings The speed at which your \
computerwites (hums) data to

File Edit Wiew Tools Internst Help

@ Backur

1. Select Images

Select CO-R Drive: the CD affects the CD quality.

Specify Backup Settings

—

>~ e ——— CD Title: ‘ | In general. slower recording
3 StartBackup ) speeds create CDs that are less
o —_— = Speed: ‘Faslesl "| prone to errors.
[7] Werify after backug. ltis always a good idea to
choose "“erify after backup' to
Use the Verify feature to testthe data on the CO-R after hackup is ensure thatthe backup was
complete. This will take longer, butwill determine whether the backup was successiul
successhul

Space on CO-R

{99 Rstun o ain Mo Usad 000 B, Cumant Session 122 &1 KB, Remaining 702 70 ME

(] )
100 200 300 400 500 600

(1) The file sizes abowe are estimates anly. The CD burning process
may not be completed i the remaining space is low,

o J

o5 You can add images to a CD-R/RW disk that already contains images.
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Adding Still Images to the Memory Card in the
Camcorder

You can add still images (JPEG) from the computer to a memory card in the
camcorder.

'0\ o Unable to upload the still images to the disc.
\&¥] o When using this function, you cannot add the still images to a memory card

using a card reader/writer. Please insert the card to the camcorder to add
images.

B Adding Still Images to the Memory Card

1 Connect the camcorder to the computer ([ 25).

2 Click [Acquire & Camera Settings] in the Main Window.

¥ ZoomBrowser, X - C:ADocuments and SettingsiCanoniy Documentsidy Pictures

File Edit View Tools Internet Help

[ Tasks @ ] @ Slide: Show a Search [l
—_——— N

o~
¢ _@ Aequire & Camera Setiings

Lrﬁ-’k. e ——— | My Pictures + + HB-0- IF@% _}—f
Wﬁ:' View & Classily 7

Zoom Mode | Serol Mode | Preview Mode

S
& - 1
l Intemet

l@ . %) 200%_01_15 /

i
IMGjJ,d’ 102.0PG
Al A

3 Click [Connect to Camera].

7. ZoomBrowser, B - C:ADocuments and Settings\Canoniy Documentsiy Pictures

Fil= Edit View Tools Internet Help

_ — =
[ Tasks @ ] ]yl View 2tties DP Slide: Show “a Search iif Delet
@ Acquire & Camera Settings J | Zoogiley | Scrol Mode || Preview Mode e i — L
— T_—— = My Pictures € T R-0- I_k'!s‘u J-—-———""' 4,? Filter Taal
| Corinec t to Carnera
s

rtonnect to EOS Camera

Acquire Images from b emomy Card

Wiew & Clazsify

EE
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4 Click the [Set to Camera] tab and click [Uploads images to
the cameral.

' CameraWindow - Canon 3 %% %

| Acquire Images | Print 'J Set to Camers |!Qemote shooting‘i

Set My Camera

;;&F’ Confirms/changes camera settings

-‘Ql Uploads images to the camera

Diizplayz thiz screen when the camera is connected

5 Select the still images you wish to save and click [Open].

Upload Images from Disk E]@
Look in: | £ 20004 01_15 Jo@rm
ME_0101 g IMG_0103
.F\Ie name: ﬁwﬁ_m m.IPG"
Files of twpe: IEM v
6 Select the image size and click [Add].
Anid image g|

Image will be added after zetup 1z performed.

(%) Add image &z iz
() Send after changing the image to VGA size [B40<480 dats)

Cancel

'0\ When you upload images edited with another application, images properties
\&¥ may be lost.
6 |
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| Using Various Functions

Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

'0\ To use this function, the e-mail software must be enabled as MAPI client. For
\&¥ details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

1 ZoomBrowser B - C:ADocuments and SettingsACanon\My Documentsiy Pictures

File Edit View Tools Internet Help

[ Tasks @
@ Acquire & Camera Settings

=
‘JF- Wiew & Clazsify
\@ E dit

]

| )

|

g R (S
| Tr— /

@ Slide: Show a Search
4 &0 Q = (Frew ]

Zoom Mode | Serol Made | Preview Mode

My Pictures

‘E 200X_01_15

File Edit View Tools Internet Help

— p =
[ Tasks e] perties @Wﬁ\ide Shaws “Q Search ﬁlﬁ Delet: ate

@ Annuire & Camera Settings ] oo klode | Seroll Mode | Preview Mode W ., N -

B B+ (@ ogNa 3 - [
Ir Wiew & Clagsify ]
l@ Pririt

l@ Edit ] | | | :

& | m %

{@ (- Jh IMG_DII= MG_DlD2/
S || il |
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Select the still images you wish to send and click [Change

Image Size].

7 ZoomBrowser BX - C:ADocuments and Setti

- [=)x)

File Edit View Tools Internet Help

AT
t@: Ernail Images

ngsiCanony DocumentsiMy Pictures

L Select Images J

Zoom Maode | Seroll Mode | Preview Mode |

t |H-0-

(& &

}‘ 4,? Filter Taal

= = My Pictures L
( 2 Change Image Size |
= = %) 200%_01_15

3 Sendor Save 7 -

4 Finish ]

i

[ 3 Retun to Main Menu

Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images

IMG_0103.JPG  IMG_0104.0FG

unchanged]. Normally select [Resize and compress images into JPEG type].
- [Long side/Short side]: Selects the long or short side and sets the image size

in numbers.

- [Quality]: The lower the quality, the coarser becomes the still image and

smaller the file size.

- Pressing [Calculate] displays the file size after the compression as [Modified

File Size].

- You can check the compressed still image by pressing [Preview Images].

Tools

ernet  Help

9 Rietumn to Main Menu

—"N

7 ZoomBrawser, EX - C:\Documents and SettingsiCanoniiy Documents

Image Settings

B

& Sendimages unchanged

© Long side:

O Resize and compress images inta JFEG type

1_ E:I 'E‘ pixels

© Shart side:
= B o
b
Cluality:
Qriginal File Size: G2.8KB
Modified File Size: 0.0 bytes

‘ pixels

Highest

1) wWhenthe image size is large, the images may notbe sent propely by

your email program. A total size of 300KE is recommended

You may wantto reduce the size
and/or quality of the photos to a
totalfile size of less than 300 KB.
This insures that people can
recene your email

Decrease the file size ofthe
exported photos by reducing
the dimensions. ZoomBrawser
EX maintains the phota's aspect
ratio during resizing,

“ou can also reduce the quality
ofthe photo. The image may not
look as sharp. butthe file size
will be smaller.

High qual\ly Lowe qualny
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Select to send still images by e-mail or to save the still
images in a folder and click [Finish].

* If you selected [Create a new email], your e-mail software starts and the
selected still images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail software
not supporting MAPI does not start automatically. In this case, select [Save the
images in a folder...].

* If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still image
to a message.

#1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents
Fle Edit View Tools Intsrmet Help

{@' Email Images STEFP 3: Send the email o itto send later Help

l 1. Select Images

Email Settings If your email program supports

WM&PI, you can attach the photos
directly from ZoomBrowser EX,

@ Creste anew email
2. Change Image Size

|
|
L Send or Save J

(*) This option is only svailable if you use an email program that

supports MAPL e.g. Microsoft Outlook Express iR IEE o MESE(D S i

photos in afolder, startyour
email program, and then attach
() Seve the images in afolder to send through an email program thet does the photos to & new email.

not support MAPL

Thern:

1. Startyour preferred email program.
2. Aftach the images to an email as normal and send.

I Return to Main Menu
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Running a Slide Show

You can view selected still images in a slide show.

1 Click [View & Classify] in the Main Window.

You can also view a slide show by clicking [Slide Show] on Application Tool Bar.
Please skip forward to step 4.

&1 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents\My Pictures
File Edit View Tools Internet Help

‘ [ Tasks a ] ‘ - WYiews Image "a_::| Praperties(@ Slide: Shnw] @ Search Delete ‘*’ Rintate
E@ Acquite & Camera Setings J Zoom Made | Scrall Mode | Preview Mode

= My Fictures € 42 [H-0-[| %R e | Filer Todl
= 7 View & Classiy )

D T —— ~

r - 7 ¥ 200¢_01_15

Il

¥ ZoomBrowser, X - C:ADocuments and SettingsiCanoniy Documentsidy Pictures

DP Slide: Show @ Search ﬁr DEISEE.

Zoom Made | Scroll Mode | Preview Mode |

9]
J] MyPotuss €15 2+ | HO- [ M]E =N
)
T
|
}

[x]&
. A 4.
¥ 200%_01_15 l__ 1

3 Select the images and click [Setup Slide Show].

Fil= Edit View Tools Internet Help

[ Tasks

@ Acquire & Camera Settings
=

gﬁj} Wiews & Classity

Wiew a¢ a Slide Show

—\

Rename Multiple Files

Clazzify into Folder

Search

Help
Jr—-f" ,f?:ﬂ Filter Tl

Zoom Mode | Serall Made | Preview Mode

Select Images

My Pictures

=
| 2 Setup Slide Show
S~

3 Start Slide Show .

| R R T

H I Return to Main Menu ] ‘H
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Select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or
title.

* [Advance to Next Slide]: Select to advance manually or automatically. When
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
itin a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

w1 ZoomBrowser, EX - C:\Documents and SettingsiCanonty Documents B{E‘gl
File Edit Wew Tools Internet Help

@ Vie de Show al Help

1. SelectImages | f Slide Show Settings \
» oo|
r .

|

=l
3
3
@
o
E}
E

-]

3. Gtart Slide Show. l

I

Image Size: O Actual Size

@ Best Fit
1[4 Retun to Main Menu © Meaximum Stretch

Image Information, © Mo Information
@ Shaw Information
O Controls Only

R EHMEE
HEEECEEE

EEDOCRIm o
CEHGOC

Advance to Next Slide: @& On clicking the left mouse buttan
O Every 3 second(s)
\ .

\_

pm—

Click [Start Slide Show].

Click in the lower right corner to end the slide show.
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Adding Sound to a Still Image

* You can add a sound to an image. The sound file needs to be in WAVE type
(extension “.wav”) or in MIDI type (extension “.mid” or “.midi”).
» The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

\-'iew Tools  Intermet  Help
Copy Chrl+C

Copy ko Folder...
Miowe to Folder. ..

Select all Chrl+a

Cleat Selection Chrl+R

Rotate Image. ..
Rotate According o Ratation Information

Change Star Batind

T
L)
L
a]
Z
@
[
=
O
U"

Edit Image. ..
o Manage My Camera...

2 Click [Add].

w1 Sound

Currently Selected Sound File:

[ OF. ] [ Cancel

3 Select the sound file and click [Open].
4 cCiick [OK].

» The sound file will be copied to the same folder as the image.
* To play back the sound, select an image with a sound icon and select [Play
Sound] from the [Edit] menu.

2Py © Toremove sound from an image, select [Remove] on the Sound window in
&2 step 2. disappears and the copied sound file will be deleted.
o The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the
Camcorder

You can change and confirm the owner name of the camcorder.
1 Connect the camcorder to the computer ([ 25).

2 Select [Canon CameraWindow] and click [OK].

Canon ¥¥ ¥ ¥

Camera connected

Select the program to launch for this action:
Canon Carmeraiy/indow
[Downloads Images From Canon Camera

""\I—_.I._ Canon EQS Utility
¢ [ ownloads images from EQS camera

72 Microzoft Scanner and Camera Ywizard
Dowwnload pictures from a camera or scanner

[ &shwaps uze this program For this action

r Cancel

3 Click the [Set to Camera] tab and click [Confirms/changes
camera settings].

& CameraWindow - Canon ¥4 H:4 %

rﬁcquirelmages Pririt | | Set to Camera | |3emate shooting

| -

Set My Camera

i%j: Confirms/changes camera settings

-%Ql Uploads images to the camera

i

Dizplays this screen when the camera is connected

Freferences...
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4 Enter the camcorder’s owner name and click [OK].

£ Camera Settings

Camera Model: Canon 4k % %

Firmware Version: 1.0.0.0

Owiner's Mame:

Input a camcorder owner name ——— Canon |

here (up to 31 characters).
[ Cancel ] l Apply

e
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when
reinstallation is required to fix corrupted files.

70\ Users of Windows 2000 and Windows XP must first log in as an Administrator
\&¥] to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] »
[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

§) Internet __J My Documents
Inkernet Explorer
2 Eormail |19} My Pictures
LJJ Qutlook Express @ Set Program Access and Defaults

S windows Catalog

", MSN Explarer -“ ‘Windows Update
@ Windows Media Play: I Accessaries

. M@ Canon Utilities
¥
'\:{& Windaws Mavie Mal .jf_" Games

dj Startup
@ Tour Windows XP

& Internet Explarer

e M5 Expl
@ ZoomBrowser Ex b P

Lﬁj Cutlock Express

dj CameraWindow ¥
I EOS Utiliey 3
I MovieEdit Task  »
@ RAW Image Task  #

3

ﬁ ZoamBrowser EX
[Z] ZoomBrowser EX Readme
¢ Remote Assistance i

@ ‘Windows Media Plaver

All Programs  ® ﬂ Windaws Messenger

2% © Other programs in [Canon Utilities] can also be uninstalled in the same way.
4 o Uninstall all programs in [Canon Utilities] when you have uninstalled
ZoomBrowser EX.
o RAW Image Task is used with Canon digital camera. The camcorder does
not support the program, but you can uninstall the program in the same way
as uninstalling the ZoomBrowser EX.
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Uninstalling the TWAIN Driver/WIA Driver

1 Connect the camcorder to the computer ([1] 25).

2 If a window for selecting an application program or the
Scanners and Cameras Wizard appears, click [Cancel]. If
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

4 Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation ([_] 88).

5 Windows 98/Windows 2000:

1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.

2. Click [OK] to close the window.

3. Turn the camcorder POWER switch to OFF and remove the USB cable from
the computer.

4. Click the Windows [Start] menu and select [Programs], [Canon Utilities], [DV
TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”".

Windows Me:

1. Delete the camcorder icon from the [Scanners and Cameras] folder.

2. Click [OK] to close the window.

3. Click the Windows [Start] menu and select [Programs], [Canon Ultilities], [DV
WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”".

6 When the Confirm Uninstall window appears, click [OK].

The uninstall process starts.

17 When the Maintenance Complete window appears, click
[Finish].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

= Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements: Built-in USB port on a system pre-installed with Windows 98,
Windows Me, Windows 2000, or Windows XP.

= There is no disc or memory card in the camcorder.
Insert a disc or a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the "™ /¢y to 3. Then, select DISC or
CARD in the MEDIA SEL.@3 from the SYSTEM SETUP menu.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([ 1] 25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

=> TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the DIGITAL
VIDEO SOLUTION DISK (remove the check marks from the other programs
when prompted to select the programs to be installed).

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the "™ /¢y to 3. Then, select DISC or
CARD in the MEDIA SEL.@3 from the SYSTEM SETUP menu.

Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

Cannot install the TWAIN Driver/WIA Driver correctly.
= Does the system have a built-in USB port and did it come with Windows
98/Windows Me/Windows 2000 preinstalled? (For Windows XP, no driver
is necessary to be installed.)
= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([ 1] 25) and check the
connection.
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Ensure that you are using the correct cable and that its connectors are in good
shape.

= Are you using the power adapter to power the camcorder?

= If the problem is not mentioned above, the TWAIN Driver/WIA Driver may
not have been recognized by Windows.
Uninstall and reinstall the driver. (For Windows XP, no driver is necessary to be
installed.)

TWAIN Driver/WIA Driver Uninstallation

If you have problems when uninstalling the driver, use the following procedures to
remove it.

’0\ The [Inf] folder contains numerous files that are critical to the computer’s
\ o /|

operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

2Py Use the procedures below for the following circumstances too.

- If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].

- If [Canon Camera] or your camcorder model name does not appear in the
[Scanners and Cameras Properties] or [Scanners and Cameras].

- If you connected the camcorder to the computer via the USB cable before
installing the Digital Video Software.

Windows 98/Windows Me

Leave the camcorder connected to the computer.

1

& N

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
The [System Properties] dialog appears.

Click the [Device Manager] tab.

If [Canon Camera] appears under the [Other Devices] and/or
[Imaging Devices] categories, use the following procedures
to delete it.

1. Select [Canon Camera] and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Double-click the [My Computer] icon on the desktop
followed by the [C:] drive and the [Windows] and [Inf]
folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
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3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files
and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

6 Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

~J

In the [Inf] folder, double-click [Other] folder to open it.

8 Find and delete the [Canon.IncCAPxxx.inf] and
[Canon.IncCDVxxx.inf] file.
* The xxx represents numerals.
« If the above file is not contained in the [Other] folder, you do not need to delete
anything.

Windows 2000

Leave the camcorder connected to the computer.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
Click the [Hardware] tab.

Click the [Device Manager] button.

AN DB ON -

If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedures to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click the
mouse button and select [Delete].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
Remove all copies of [Canon Camera] or your camcorder model name that
appear in the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.

6 Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. In the [Advanced setting] section, set the [Hidden files and folders] category
to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.
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4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

T Look for the file for Canon digital camcorders starting with
[Oem*].

* A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem*.inf] file. The two constitute one set.

» There may be many file sets starting with “Oem”.

* If you double-click an [Oem*.inf] file, the Windows Notepad program will start
and show the file contents. Click each [Oem*inf] file until you find one that
contains “*** Canon Camera Driver Setup File**” in its first line. When you
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.

Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct
files.

If You Were Using ZoomBrowser EX Version 2 or 3
(This manual explains version 5.x)

Titles and comments added using a prior version than ZoomBrowser EX
version 4 do not appear in ZoomBrowser EX 4 or higher.
=> Titles and comments added using a prior version of ZoomBrowser EX will
not be displayed. Use the following procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in which you
installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].

3. Select the database you were using until now (C:\Program Files\Canon\
ZoomBrowser EX\Program) and click the [Start] button.

Please note that with ZoomBrowser EX 4 or higher, both titles and comments
appear in the comment list.

Cannot find the image folders saved with a prior version than ZoomBrowser
EX 5.x.
= Image folders saved under the [Program Files] folder (such as [Image

Library One]) cannot be displayed in the Main Window’s Folder Area of

ZoomBrowser EX 4 or higher. Use the following procedure to display

them.

1. In Windows Explorer, open the [Program Files] folder under the folder in
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\lmage Library One).

2. Select the image folder you wish to display and copy the folder to a different
destination.
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